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Analysis 
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Analysis

| Documents

/ T4 - OSP Stage 2040 for ASAP Paint V2.0 사용

/기존 1.0에서 삭제된 부분이 있으나 크게 기능에 미치는 영향
이 없다고 판단, 기존 Test Case 그대로 적용

413년 6월 6일 목요일



Category-Partition
Testing 

513년 6월 6일 목요일



Category-Partition Testing

| Source

/매 테스트마다, Snapshot을 Branches안에 생성
6/3, r119에서 추출된 snapshot으로 테스트 실행

613년 6월 6일 목요일



Category-Partition Testing

| Mantis

/지난번 테스트에서 에러난 부분은 전부 해결된 것을 확인 할 
수 있었음

713년 6월 6일 목요일



Category-Partition Testing

| Test Case1. 시작방식
Test Case 시작방식 저장할까요? 기존파일저장유무 종료 결과

1.1.1 새 파일 O O X Pass
1.1.2 새 파일 O O O Pass
1.1.3 새 파일 O X X Pass
1.1.4 새 파일 O X O Pass
1.1.5 새 파일 X O X Pass
1.1.6 새 파일 X O O Pass
1.1.7 새 파일 X X X Pass
1.1.8 새 파일 X X O Pass
1.2.1 불러오기 O O X Pass
1.2.2 불러오기 O O O Pass
1.2.3 불러오기 O X X Pass
1.2.4 불러오기 O X O Pass
1.2.5 불러오기 X O X Pass
1.2.6 불러오기 X O O Pass
1.2.7 불러오기 X X X Pass
1.2.8 불러오기 X X O Pass
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Category-Partition Testing

| Test Case2. 저장하기
Test Case 새 파일로 시작여부 메뉴 결과

2.1 O 저장하기 Pass

2.2 O 다른 이름으로 저장 Pass

2.3 X 저장하기 Pass

2.4 X 다른 이름으로 저장 Pass
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Category-Partition Testing

| Test Case3. 이미지기능
Test Case 영역선택유무 메뉴 클립보드유무 결과

3.1.1 O 이미지복사 O Pass
3.1.2 O 잘라내기 O Pass
3.1.3 O 이동 O Pass
3.1.4 O 삭제 O Pass
3.1.5 O 회전 O FAIL
3.1.6 O 반전 O Pass
3.1.7 O 이미지복사 X Pass
3.1.8 O 잘라내기 X Pass
3.1.9 O 이동 X Pass
3.1.10 O 삭제 X Pass
3.1.11 O 회전 X FAIL
3.1.12 O 반전 X Pass
3.2.1 X 이동 O Pass
3.2.2 X 삭제 O Pass
3.2.3 X 회전 O FAIL
3.2.4 X 반전 O Pass
3.2.5 X 이동 X Pass
3.2.6 X 삭제 X Pass
3.2.7 X 회전 X FAIL
3.2.8 X 반전 X Pass
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Category-Partition Testing

| Test Case3. 이미지기능

/ 이미지 회전 기능은 회전기능만 정상작동

/ 각도 지정(Function 4.1.2) 이후 이미지열화현상 발생

/ Test Case : 3.1.5, 3.1.11, 3.2.3, 3.2.7

/ 멘티스에도 보고된 내용이라 일단 보류

1113년 6월 6일 목요일



| Test Case3. 이미지기능 (After)

10도 회전
 시 이미

지 열화
확인

1도씩 10번 수행했을 때 결과

Category-Partition Testing

1213년 6월 6일 목요일



Category-Partition Testing

| Test Case4. 붙여넣기
Test Case 이전동작 클립 보드 유무 메뉴 결과

4.1.1 복사 O 붙여 넣기 Pass

4.1.2 잘라내기 O 붙여 넣기 Pass

4.1.3 - X 붙여 넣기 Pass
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Category-Partition Testing

| Test Case5. 이미지 리사이즈
Test Case Width 비교 height 결과

5.1.1 숫자 > 숫자 Pass
5.1.2 숫자 = 숫자 Pass
5.1.3 숫자 < 숫자 Pass
5.2.1 문자/특수문자 문자/특수문자 Pass
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Category-Partition Testing

| Test Case6. 그리기
Test Case 색상 선택 방법 도구 결과

6.1.1 직접선택 연필 Pass
6.1.2 직접선택 브러시 Pass
6.1.3 직접선택 사각형 Pass
6.1.4 직접선택 원 Pass
6.2.1 스포이드 연필 Pass
6.2.2 스포이드 브러시 Pass
6.2.3 스포이드 사각형 Pass
6.2.4 스포이드 원 Pass
6.3.1 default 연필 Pass
6.3.2 default 브러시 Pass
6.3.3 default 사각형 Pass
6.3.4 default 원 Pass
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Category-Partition Testing

| Test Case7. 확대 축소
Test Case 확대 축소 결과

7.1 0 1 Pass

7.2 1 0 Pass

7.3 1 1 Pass

7.4 1  n Pass

7.5 n 0 Pass

7.6 n 1 Pass

7.7 n n Pass
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Pairwise Testing 
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Pairwise Testing

| Category-Partition Testing을 이용해 뽑아낸 Category들을 이용하여 Pairwise Testing을 시행.

| 이미지기능의 회전기능은 오류가 있는 기능으로 제외함

시작방식 저장하기 이미지기능 붙여넣기 리사이즈 색상선택 그리기도구 확대축소 지우개

새파일 저장하기 복사 붙여넣기 숫자 직접선택 연필 확대 지우개

불러오기 다른이름으로
저장

잘라내기 문자/특수문
자

스포이드 브러시 축소

이동 사각형

삭제 원

회전

반전
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Pairwise Testing
| PICT

/ 붙여넣기는 영역선택에서 복사와 잘라내기에서만 가능하므로 조건절에 표시해주어야 한다.

/ 출력시엔 보기 편하게 엑셀파일로 출력

1913년 6월 6일 목요일



Pairwise Testing

| PICT

/ 20가지의 pair가 출력, Notest부분은 따로 test하지 않아도 된다는 의미로 사용

2013년 6월 6일 목요일



Pairwise Testing

| PICT

/ 20가지의 Test모두 정상적으로 작동

2113년 6월 6일 목요일



Sonar 

2213년 6월 6일 목요일



Sonar

|설치법

/ Sonar
http://www.sonarsource.org/downloads/

2313년 6월 6일 목요일



Sonar

|설치법

/ http://docs.codehaus.org/display/SONAR/Installing+and
+Configuring+Sonar+Runner

2413년 6월 6일 목요일



Sonar

|설치법 (Sonar)

/원하는 디렉토리에 풀고, 다음 파일 실행하면 설치 완료

/ sonar-3.5.1/bin/[my os]/sonar.sh

/ localhost:9000 으로 접속가능

2513년 6월 6일 목요일



Sonar

|설치법 (Sonar-runner)

/원하는 디렉토리에 풀고, 다음과 같이 환경변수 설정

/ sonar-runner -h 실행시 다음과 같이 뜨면 성공

2613년 6월 6일 목요일



Sonar

|사용법

/ sonar-project.properties 파일에
다음과 같이 작성

2713년 6월 6일 목요일



Sonar

|사용법

/ sonar-runner 실행하면
성공적으로 sonar 안에 프로젝트가 추가됨

2813년 6월 6일 목요일



Sonar
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Sonar

| Duplications (코드 중복)

/전체 2116Line 중 382Line 중복, 18.1%

/
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Sonar

| Duplications (코드 중복)

/비슷한 기능들 중에 중복이 
많이 발생

/하나의 도구에 하나의 클래
스를 사용하기 보단 기능단
위로 나누는 과정이 필요

3113년 6월 6일 목요일



Sonar

| Duplications (코드 중복)
Package Class Line(Nb Lines) Other

ASAP.Tools CircleTool 16(+14) RectangleTool, 17

41(+18) CircleTool 70,97,125

BrushTool 24(+35) PenTool 31
Erase Tool 46

62(+21) EraseTool 23

85(+20) PenTool 69

85(+10) PenTool 69
EraseTool 84
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Sonar

| Duplications (코드 중복)
Package Class Line(Nb Lines) Other

ASAP.Tools EraseTool 23(+21) BrushTool 62

43(+51) PenTool 28

46(+35) BrushTool 24
PenTool 31

84(+10) PenTool 69
BrushTool 85

PenTool 28(+51) EraseTool 43

31(+35) BrushTool 24
EraseTool 46

69(+20) PenTool 69
BrushTool 85

69(+10) EraseTool 84
BrushTool 85
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Sonar

| Duplications (코드 중복)

Package Class Line(Nb Lines) Other

ASAP.Tools MoveTool 13(+22) SelectTool 13

SelectTool 13(+22) MoveTool 13

RectagnleTool 16(+20) CircleTool 16

ASAP.Canvas MYCanvas 206(+13) MYCanvas 243
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Sonar

| Severity

/ Violations 425개 중, Critical 17, Major 212, 즉 47.2%

3513년 6월 6일 목요일



Sonar
| Severity - Critical

/ Empty If Stmt
/ If statement에서 공백인 부분 총 15개 발견

Package Class Line
ASAP.Tools CircleTool 18, 23

MoveTool 20, 23
PipetteTool 22, 26

RectangleTool 20, 30
SelectTool 20, 23
BrushTool 42
EraseTool 64
PenTool 49

ASAP.Canvas MYCanvas 132, 136
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Sonar
| Severity - Critical

/ Empty Finally Block
/ Finally 선언 후 공백인 부분 1군대 발견

Package Class Line
ASAP.Canvas MYCanvas 114
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Sonar
| Severity - Critical

/ Security - Array is stored directly
/ Array 전체를 직접 접근한 경우, 1군대 발견

Package Class Line
ASAP.Canvas Image 264
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Sonar

| Severity - Major

/잠재적인 위험을 담고 있는 부분으로서 100% 수정하지 않아
도 됨

/ Method Name, Package Name, Local Variable Name

/위 3가지의 경우 이름 규칙이 잘못된 경우 발생하는데 이부분
은 제외하기로 함.(각 97개, 23개, 17개 발견됨)
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Sonar
| Severity - Major

/ Parameter Assignment
/ method에서 선언한 변수에 직접 접근 한 경우, 총 20개 발견

Package Class Line
ASAP.Tools BrushTool 93, 94, 102, 103

EraseTool 92, 93, 101, 102
PenTool 77, 78, 86, 87

ASAP.Canvas MYCanvas 129, 130, 147, 148, 331, 332, 404, 405
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Sonar
| Severity - Major

/ Simplify Boolean Expression
/ if (a == true)같이 사용한 경우, 총 10개 발견

Package Class Line
ASAP.Tools MoveTool 19, 36

BrushTool 17
CircleTool 21
EraseTool 19
PenTool 34

PipetteTool 21
RectangleTool 25

SelectTool 19
ASAP.Canvas MYCanvas 268
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Sonar
| Severity - Major

/ If Else Stmts Must Use Braces
/ {}로 묶이지 않는 조건절인 경우, 총 9개 발견

Package Class Line
ASAP.Tools FileManager 8

ASAP.Canvas SelectedImage 67
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Sonar
| Severity - Major

/ Visibility Modifier
/ 가급적 protected보단 private를 사용, 총 8개 발견

Package Class Line
ASAP.Tools VirtualTool 7,9,10,12,13,15,16

ASAP.Canvas VirtualImage 6
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Sonar
| Severity - Major

/ Final Class
/ 더이상 상속되지 않는 클래스의 경우 Final 선언, 총 6개 발견

Package Class Line
ASAP.Tools CircleTool 19, 36

EraseTool 17
MoveTool 21
PenTool 19

PipetteTool 34
RectangleTool 21
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Sonar
| Severity - Major

/ Unused local variable
/ 사용되지 않는 변수, 총 4개 발견

Package Class Line
ASAP.Canvas MyCanvas 72,73,74,76
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Sonar
| Severity - Major

/ Avoid Duplicate Literals
/ 가급적 중복된 String값은 변수로 사용하도록, 총 3개 발견

Package Class Line
ASAP FileManager 53, 55, 57

jpg, gif, png가 각 4번씩 더 등장
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Sonar
| Severity - Major

/ Avoid Print Stack Trace(use a logger call instead)
/ printStackTrace를 가급적 사용 자제, 총 3개 발견

Package Class Line
ASAP FileManager 69, 97

33
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Sonar
| Severity - Major

/ Avoid Commented-out lines of code
/ 코드라인에 주석을 처리한 경우, 총 3개 발견

Package Class Line
ASAP.Canvas Image 121

MYCanvas 118
SelectedImage 71
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Sonar
| Severity - Major

/ Unnecessary Local Before Return
/ return하는 변수가 바로 이전에 선언된 경우 불필요함, 총 2개 발견

Package Class Line
ASAP.Canvas MYCanvas 159, 165
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Sonar
| Severity - Major

/ If Stmts Must Use Braces
/ if 구문에 {}이 사용되지 않은 경우, 총 2개 발견

Package Class Line
ASAP.Canvas MYCanvas 268

SelectedImage 34
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Sonar
| Severity - Major

/ Cyclomatic Complexity
/ 최대 10으로 허용되있는데 13임, 1군대 발견.

Package Class Line
ASAP.Tools CircleTool 28 (아래에 있는 함수)
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Sonar
| Severity - Major

/ Ncss Method Count
/ NCSS 84줄이 나왔음, 1군대 발견.

Package Class Line
ASAP.Tools CircleTool 29 (아래로 쭉)
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Sonar
| Severity - Major

/ Avoiding Catching NPE
/ , 1군대 발견.

Package Class Line
ASAP.Canvas MYCanvas 109
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Sonar
| Severity - Major

/ Simplify Boolean Return
/ Boolean을 리턴할 경우 if stmt를 없앨수 있음, 1군대 발견.

Package Class Line
ASAP.Canvas MYCanvas 360
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Sonar
| Severity - Major

/ Constructor Calls Overridable Method
/ , 1군대 발견.

Package Class Line
ASAP.Canvas Image 19

5513년 6월 6일 목요일



Sonar

| Complexity

/ Complexity를 Method, Class, File 각각에 대한 평균값을 제공

/ Complexity/Class = Complexity/File 이나, 다른경우도 있음
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Sonar

| Complexity / Method
Package Class Complexity / Method

ASAP.Tools (2.7) CircleTool 4.8
BrushTool 4.2
EraseTool 4.2
PenTool 3.6

MoveTool 3.3
RectangleTool 3.3
PipetteTool 1.8
SelectTool 1.8
VirtualTool 1.1

BrushToolTest 1.0
CircleToolTest 1.0
EraseToolTest 1.0

PipetteToolTest 1.0
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Sonar

| Complexity / Method
Package Class Complexity / Method

ASAP (2.5) FileManager 6.0
GUIMain 1.5

MousePointer 1.0
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Sonar

| Complexity / Method
Package Class Complexity / Method

ASAP.Canvas (2.0) Image 2.6
SelectedImage 2.4

MYCanvas 2.3
ImageTransterable 1.8

VirtualImage 1.6
MYCanvasTest 1.0
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Sonar

| Complexity / Method
Package Class Complexity / Method

ASAP.test (2.5) ASAPTEST1 1.2
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Sonar

| Complexity / class
Package Class Complexity / Method

ASAP.Canvas (25.5) MYCanvas 64.0
Image 31.0

SelectedImage 24.0
MYCanvasTest 14.0
VirtualImage 13.0

ImageTransterable 7.0
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Sonar

| Complexity / class
Package Class Complexity / Method

ASAP.Tools (10.5) EraseTool 21.0
BrushTool 21.0
CircleTool 19.0
PenTool 18.0

MoveTool 13.0
RectangleTool 13.0

VirtualTool 9.0
PipetteTool 7.0
SelectTool 7.0

BrushToolTest 2.0
CircleToolTest 2.0
EraseToolTest 2.0

PipetteToolTest 2.0
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Sonar

| Complexity / class
Package Class Complexity / Method

ASAP (9.0) FileManager 18.0
MousePointer 6.0

GUIMain 3.0
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Sonar

| Complexity / class
Package Class Complexity / Method

ASAP.test (6.0) ASAPTEST1 6.0
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Sonar

| Complexity / file

/ Complexity / file 나머진 같고, ASAP 패키지만 다름
Package Class Complexity / Method

ASAP (6.8) FileManager 18.0
MousePointer 6.0

GUIMain 3.0
Window 0.0
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Sonar
|

Complexity
/

ASAP.Canvas
/ /class 는 높은 복잡도를 가지지만, /method는 낮은 복잡도를 가짐
/
상당히 많은 method가 구현되어 있음, 다양한 클래스로 세분화 하여야 함

/
ASAP.Tools

/ /method 가 높은 복잡도를 가짐
/ class에 비해 너무 거대한 method를 다루고 있거나, class에 비해 method의 갯수가 너무 적음. 메서드 자체를 나누어서 저
장을 하거나, 클래스를 묶어야 함

/
ASAP

/
평균값은 적당하나, /method에서 FileManager가 혼자서 너무 큰 Complexity를 갖고 있음

/ FileManager를 좀더 분리해서 적절히 나눠갖게 하던가, 전체 패키지에 골고루 기능을 분배해야 하는 필요성이 있음
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JArchitect 
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JArchitect

|설치

/ http://www.jarchitect.com/
JavaDependDownload.aspx

/다운로드 후, 파일 실행

6813년 6월 6일 목요일
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JArchitect

|설치

/ File -> New Project

/ Browse, 내 프로젝트를 올림
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JArchitect

|설치

/ File -> New Project

/ Browse, 내 프로젝트를 올림
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JArchitect

|설치

/ File -> New Project

/ Browse, 내 프로젝트를 올림
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JArchitect

|설치

/ Add Eclipse Workspace

/내 이클립스 workspace 선택

/
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JArchitect

|설치

/그리고 F5를 누른다
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JArchitect

|사용법
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JArchitect

|사용법

/ Dependency Graph, Dependency Metrics, 
Metrics, Project Property 각 탭이 결과를 제공
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JArchitect
| Dependency Matrix

/ 이 메트릭스는 중앙의 45도 각도로 있는 
검정색 실선을 중심으로 대칭이다

/ 초록색은 세로축의 메소드가 가로축의
메소드에게 사용된다는 뜻

/ 파란색은 세로축의 메소드가 가로축의
메소드를 사용한다는 뜻

/ 패키지, 클래스, 메소드의 단위를 설정 가능

7613년 6월 6일 목요일



JArchitect

| Dependency Matrix

/검정색은 간접적으로 서로를 
사용하고 있다는 뜻
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JArchitect

| Project Property
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JArchitect
| Metrics

/ 트리맵의 모습은 코드의 계층구조를 의미

/ 큰 사각형은 클래스, 그 안의 사각형은 해당 
클래스의 메서드

/ 마우스를 올리면 선명하게 볼 수 있고, 그 
크기와 위치를 통해 클래스 내의 계층 구조
를 알 수 있음

/ 영역이 크면 코드라인의 수가 많음
(Byte Code Instructions)
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JArchitect

| Dependency Graph

/ ASAP는 svntest(저장소)에 들
어있으며 missing, rt를 사용
(의존한다)

/ rt의 82개의 메서드 사용

/ missing의 6개의 메서드 사용
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JArchitect

| Dependency Matrix
/ ASAP.Canvas와 ASAP.Tools 클래스는 
서로 직접적으로 사용하고 있으며 각각 
서로 1번 이용, 즉 Dependency Cycle 
의 길이가 2

/ A패키지가 변하면 B패키지도 변하고, 
그로 인해 다시 A패키지가 영향 받을 
수 있어, 코드를 예측하지 않은 방향으
로 변할 가능성이 있음
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JArchitect

| Dependency Matrix

/ ASAP x ASAP.Canvas

/ ASAP.Canvas.MYCanvas와 
Window, 
ASAP.Canvas.MYCanvasTes
t와 Window에서 서로 사용하
고 있어서 위험 할 수 있음
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JArchitect

| Dependency Matrix

/ ASAP x ASAP.Tools

/직접 사용에서는 크게 
문제는 없으나, 
ASAP.Tools.VirtualTool
과 Window가 문제가 
생길 수 있음
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JArchitect

| Dependency Matrix

/ ASAP x ASAP.Tools, 
indirect dependencies

/ 간접적으로는 너무 많은 
dependency cycle을 이루
고 있음

/ 코드가 매우 복잡하고 위험
할 수 있음
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JArchitect

| Metrics (Code Quality)
Code Queries and Rules Items 비고

Methods too big 5
Methods potentially poorly commented 6
Methods with too many local variables 5
Methods too complex 1
Types too big 0
Methods too complex - critical 0
Methods with too many parameter 0
Methods with too many field 0
Methods with too many cohesion 0
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JArchitect

| Metrics (Code Quality)
/ Method too big

/너무 코드라인이 긴 메서드

Package Class Method
ASAP Window Window
ASAP Window LoadImage
ASAP.Canvas Image RotateImage
ASAP.Tools CircleTool UseTool
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JArchitect

| Metrics (Code Quality)
/ Methods potentially poorly commented

/주석이 없는 메서드

/전체적으로 주석 정리 잘 되어있음
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JArchitect

| Metrics (Code Quality)
/ Methods with too many local variables

/지역변수를 너무 많이 쓰는 메서드

Package Class Method
ASAP Window Window
ASAP Window LoadImage
ASAP.Canvas MYCanvas paint
ASAP.Canvas Image RotateImage
ASAP.Tools CircleTool UseTool
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JArchitect

| Metrics (Object Oriented Design)
/ 전체적으로 객체지향룰을 50개를 어겨 객체지향을 잘 따른 코드라 보긴 어렵다. 다
만 한군대에서 침해한 경우가 많기 때문에 쉽게 수정 될 수 있다.

Code Queries and Rules Items 비고
Class with no descendant should be final if possible 42
Avoid the Singleton pattern 8
Base class should not use derivatives 0
Class shouldn’t be too deep in inheritance tree 0
Don’t assign static fields from instance methods 0
Avoid empty interfaces 0
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JArchitect

| Metrics (Object Oriented Design)
/ Class with no descendant should be final if possible

/상속받은 클래스 마지막에 final keyword를 붙이지 않은 경우

/거의 대부분 Class..
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JArchitect

| Metrics (Object Oriented Design)
/ Avoid the Singleton pattern

/싱글턴패턴은 객체지향에서 사용하면 위험할 수 있음

/ ASAP.Tools의 대부분 메서드
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JArchitect

| Metrics (Design)

/전체적인 디자인은 잘 짜여져 있음
Code Queries and Rules Items 비고

Avoid packages with few types 1

Instances size shouldn’t be too big 1

Nested types should not be visible 0

Don’t use obsolete types, methods of fields 0
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JArchitect

| Metrics (Architecture and Layering)
Code Queries and Rules Items 비고

Avoid packages mutually dependent 2
Avoid packages dependency cycles 1
Higher cohesion - lower coupling 4
Projects with poor cohesion(Relational Cohesion) 0
Projects that don’t satisfy the Abstractness / Instability principle 0
Example of custom rule to check for dependency 0
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JArchitect

| Metrics (Architecture and Layering)
/ Avoid package mutually dependency

/패키지가 상호 의존해선 안되는데, 서로 상호의존 하고 있음

/ ASAP, ASAP.Tools
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JArchitect

| Metrics (Architecture and Layering)
/ Avoid package dependency cycles

/패키지는 dependency cycle을 가져선 안됨

/ ASAP Package
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JArchitect

| Metrics (Architecture and Layering)
/ Higher cohesion - lower coupling

/응집력이 높고, 낮은 결합력

/ All Package
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JArchitect

| Metrics (Visibility)

/대체적으로 우수.
Code Queries and Rules Items 비고

Methods the could have a lower visibility 0
Fields that could have a lower visibility 2
Fields should be declared as private 10

Constructors of abstract classes should be declared as protected 
on private 0
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JArchitect

| Metrics (Purity-Immutability-Side Effects)
Code Queries and Rules Items 비고

Fields should be marked as ReadOnly when possible 42
Property Getters should be immutable 0
Avoid static fields with a mutable field type 8

A field must not be assigned from outside its parent hierarchy 
types 1
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JArchitect

| Metrics (Purity-Immutability-Side Effects)
/ Field should be marked as ReadOnly when as possible

/ field는 가능한한 ReadOnly로 되어야 함

/대부분 Window 관련 필드
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JArchitect

| Metrics (Purity-Immutability-Side Effects)
/ Avoid static field with a mutable field type

/ static field는 변하기 쉬우면 안된다

/ ASAP.Tools 패키지에서만 8개
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Clover 
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Clover

| Dependency Metrics

/ JUnit Test Case 21개

/전부 전상작동
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Clover

| Coverage explorer
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Clover

| Coverage explorer
/ Statement level에서 Coverage 측정

/ 전체 Code Coverage : 50.4%

/ Covered Branches : 36.8%
Covered Methods : 50.9%
Covered Statements : 54.5%

/ Branch Coverage 비율이 유난히 낮음
Test가 Branches에 대해서는 제대로 행해지지 않음
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Clover

| Test Run Explorer

/ Junit Test Case 정상작동
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Clover

| Cloud Report

/가장 복잡도가 높으면서 Test를 하지 않은 곳을 알 수 있다
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Clover

| Cloud Report

/ Window.ResizeListener의 Code

/같은 조건절이 반복되고 
Test Case가 전혀 작성되지 않음
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Clover

| Dashboard
/ Most Complex Packages : 
ASAP.Canvas

/ Most Complex Classes : MYCanvas
/ ASAP.Canvas Package는 Test의 비
율을 더 높이고 기능을 세분화 해서 
Class를 나누는 것이 나을 것이라고 
분석됨.
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JDepend 
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JDepend
| Analysis

/ 3개의 Packages에서 Cycle Dependency 발생

/ AC = 0, 추상화가 전혀 안되어 있음

/ 3개의 Packages 모두 D가 낮아 완전 추상적이면서 안정적이거나, 완전 구체적이면서 불
안정한 패키지 두가지 모두에 속하지 못한다고 볼 수 있음

11013년 6월 6일 목요일



JDepend

| Analysis
/ 3개의 패키지는 추상화가 전혀 안
되어 있음

/ ASAP, ASAP.Canvas는 Main 
Sequence에서 많이 떨어져있음

/ 구체화 되어있는 Package는 불안
정성이 높아야 하는데 두개의 경우 
그렇지 못함

ASAP

ASAP.Canvas

ASAP.Tools
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JDepend

|결과

/ Cycle Dependency가 3개의 Package모두에게서 발생했다는 
것은 좋지 않은 현상, 패키지 내의 Class구조가 좋지 않음

/ Java의 객체지향에 맞지 않는 설계, 추상화가 전혀 되어있지 
않고 클래스간에 계층적 관계가 전혀 없음
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Eclipse TPTP 
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Eclipse TPTP

|개요

/ Test and Performance Tools Platform

/ Eclipse에서 프로그래밍 언어에 상관없이 Test와Profiling을 할 
수 있는 기반을 만들어주는 Eclipse의 project.

/ 3가지 Mode(Execution Time,Memory,Eclipse)가 지원되지만 
동시에 수행되지는 않는다
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Eclipse TPTP

|설치

/설치 전에 필요로 하는 플러그인 존재

/ WTP(Web Tools Platform) //J2EE기본설치
EMF(Eclipse Modeling Framework SDK) 
GEF(Graphical Editing Framework SDK)
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Eclipse TPTP

| 설치

/ Help -> Install New Software

/ WTP, EMF, GEF (http://download.eclipse.org/releases/juno)
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Eclipse TPTP

|설치

/ Eclipse TPTP (http://download.eclipse.org/tptp/updates)
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Eclipse TPTP

| Agent Server

/원격지 HOST에 AGENT SERVER를 설치 하므로서 원격지 
JVM에 대해서 프로파일 할 수 있는 기능 제공
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Eclipse TPTP

| Agent Server
/ http://www.eclipse.org/tptp/home/downloads/
/ Agent Controller  

/ Runtime : WINDOWS-IA32
Download
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Eclipse TPTP

| Agent Server
/ 설치폴더\bin\setConfig.bat 실행

/ 사용할 java.exe실행 파일의 전체 경로입력

/ 네트워크 Access mode입력(ALL입력)

/ Security enabled 입력(기본값사용)

/ 나머지 옵션은 기본값 사용
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Eclipse TPTP

| Agent Server
/ 원격지에 있는 EclipseTPTP 에서 로컬 호스트 실행중인 JVM을 프로파일링 하
기 위해서 Agent server 를 실행해야 한다
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Eclipse TPTP

| 실행

/ Profile As -> 2.Java Application 
/ Select Matching Item -> ok
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Eclipse TPTP
| Select Profile

/ Execution Time Analysis
/ 실행시간 분석

/ Memory Analysis
/ 메모리 분석

/ Thread Analysis
/ 쓰레드 분석

/ Probe Insertion
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Eclipse TPTP

| Execution Statistics

Package

Class

Method
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Eclipse TPTP

| Execution Statistics

상대적으로 많은 시간이 걸리는 Class
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Eclipse TPTP

| Execution Statistics
/ Window Class, 프로그램에 사용되는 이미지 불러오기 및 프로그램에 사용되
는 객체의 대부분이 생성됨
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Eclipse TPTP

| Execution Statistics

수행회수 호출한
Method

포함된
class

포함된
package

수행시간 평균수행시간 누적
수행시간

선택된 method
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Eclipse TPTP

| Execution Statistics
/ 실행시간이 가장 많이 걸렸던 window() method를 열어보니, 다음과 같이 많은 
method들을 호출하는 걸 확인할 수 있었음.
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Eclipse TPTP
| Memory Statistics

/ Live Instances :Garbage collection이 되지 않은 instances수로 Memory에 살아 잇는 instances 수
/ Avg. AGE : 한번의 Garbage Collect로부터 살아남으면 Age 하나 증가
/ Active Size(bytes) :Live Instances의 Memory Size
/ Total Instances :전체 Instances의 수
/ Total Size(bytes) :Total Instances의 수
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Eclipse TPTP

| Memory Statistics

/여기서도 window, 
canvas의 메모리 점유
율이 다른 클래스보다 
다소 많이 사용되는 것
을 확인
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Eclipse TPTP

| Thread Analysis

/몇 가지의 Test Case 수행에도 deadlock 현상은 발견되지 않음
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Eclipse TPTP
| Thread Analysis

/ Thread Visualizer
/ 직접 추가한 thread는 없고, 시스템에서 임의로 생성한 것들로만 확인 됨
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exit;_
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